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1 Installation and 
Registration

This section covers the product package, the software and 
hardware requirement, and installation for Kurzweil 1000™. 

What's in the Product Package?
The following is a general list of contents. The items you receive 
may be a subset of this list, and may depend on whether you are a 
new customer or an upgrade customer, and may depend on which 
version you are upgrading from. 

• The Kurzweil 1000 software CDs, which includes the American 
Heritage Dictionary Pronunciation WAV Files, as well as a set of 
documentation in multiple file formats.

• The Kurzweil 1000 Quick Reference.

• The Kurzweil 1000 Installation and New Features Guide.

• The NeoSpeech VoiceText CD.

• The Classic Literature CD and Guide.

• Possibly a Certificate of Ownership bearing the serial number for 
the product.
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What's in the Product Package?
You can call Kurzweil Educational Systems Customer Service to 
request any of the guides if they are not included in your package. 
The number is 1-800-894-5374. Please listen for and press the 
extension number for Customer Service.

Some of the print material is available in other file formats such as 
MP3 from www.kurzweiledu.com. There is a Kurzweil 1000 Braille 
Guide for Braille users, which is also available upon request.
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Part 1. Installation
Minimum Software and Hardware Requirements
• Processor: 1 GHz or faster. For VoiceText, a minimum of 700 

MHz is required.

• Memory: Minimum 1 GB of RAM (32-bit) or 2 GB RAM (64-bit). 

• Hard Disk Space: 16 GB hard drive for 32-bit; 20 GB for 64-bit 
with at least 15 GB of available space; additional 625 MB for 
VoiceText, and additional 300 MB for the American Heritage 
Dictionary Pronunciation WAV Files.

• Supported Operating System: Windows® 2003, Windows Server 
2008, Windows XP, Windows Vista or Windows 7. 

Note: While most of Kurzweil 1000 will work on older operating 
systems, there may be components or features such as form 
recognition and CD writing facility may not be available. Certain 
devices such as Book Courier, Book Port, and Road Runner, 
may not be supported.

• Microsoft® .NET Framework. Note: If .NET does not exist on 
your system, Kurzweil 1000 installs it during the installation 
process.

• The Kurzweil 1000 product CD.

• CD drive. 

• TWAIN-compatible flatbed scanner (check the Kurzweil 
Educational Systems Web site, www.kurzweiledu.com, for a list 
of compatible scanners). Recognizing and reading currency 
requires a color scanner.

• Sound Card: Creative Labs Sound Blaster® -compatible 16-bit or 
higher with speakers. 

• Full-size keyboard and/or a 17-button keypad.
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What's in the Product Package?
Before Installing Kurzweil 1000
Here are some important notes for consideration before installing 
Kurzweil 1000:

• Ensure that you have administrative privileges to install Kurzweil 
1000. 

• The installation is designed for the novice computer user and 
there will be two options presented to you: one which uses a 
screen reader and the other which uses the Kurzweil 1000 voice 
provided. During the installation process, Kurzweil 1000 will ask 
you to specify which you would like to use. In addition, note that 
the installation process is self-explanatory, and Kurzweil 1000 
provides help throughout the process. 

• After installing Kurzweil 1000, you must register the product. 
Your sessions are limited to two hours until your registration is 
successful. If after 30 days, you have not registered, you will no 
longer have the full product. 

• If you plan on installing VoiceText, there are two things you 
should be aware of: You must install Kurzweil 1000 first before 
installing VoiceText, and you must uninstall any older version of 
VoiceText that may be on the system. At the beginning of the 
Installation procedure, Kurzweil 1000 automatically checks for 
the existence of any older version of VoiceText on your system. If 
there is one, Kurzweil 1000 asks if you want to automatically 
remove it.

• If you have an earlier version of Kurzweil 1000 on your system, 
we recommend that you uninstall it before installing Version 12, 
although it's not necessary to do so. 

• There are a couple of situations in which you may not want to 
uninstall. For instance, you may not want to uninstall Version 7 if 
4



Part 1. Installation
you want to keep RealSpeak English, or uninstall Version 8 or 
earlier if you want to keep the RTK OCR engine. 

• If Kurzweil 1000 Version 12 is already installed on your system 
and you attempt to perform an install with the product CD, a 
message will indicate that it is already installed and you will then 
have the option of modifying, uninstalling or repairing the current 
installation. 

• Note that Kurzweil 1000 does not install scanners. Use the 
scanner manufacturer's instructions to install the scanner card, 
software, and the scanner itself. If you already have Kurzweil 
1000 installed and you are installing a new scanner, it's not 
necessary to re-install Kurzweil 1000. 

• Check for the latest information on the installation process from 
the product Release Notes in the Readme.txt file on the Kurzweil 
1000 product CD. 

• Depending on your system and the options you select, 
installation may require up to 15 minutes.
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Installing Kurzweil 1000 Version 12
Uninstalling Kurzweil 1000 
To uninstall an earlier version of the product, use the following 
procedure. Note, however, that if you want to continue using 
RealSpeak or RTK, do not uninstall. 

1. First open the Start menu from the Windows taskbar. 

2. Go to the Programs menu and select Kurzweil Educational 
Systems.

3. From the Kurzweil Educational submenu, choose Uninstall 
Kurzweil 1000.

Installing Kurzweil 1000 Version 12 
There are two options when installing Kurzweil 1000. You can use 
a screen reader or the Kurzweil 1000 voice provided. By default, 
Kurzweil 1000 installs in your C: drive. If you want to use a different 
drive or system folder, you should use the screen reader installation 
method. 

If you want to use the voiced installation, you must exit any screen 
reader first. 

Before you arrive at the place in the installation procedure where 
you must choose between these two methods, the steps are the 
same, and we'll cover them now. 

1. Make sure you have Administrator privileges. 

2. Shut down all applications. Make sure your speakers are 
plugged in, and set the volume to comfortably hear the screen 
reader.

3. Place the Kurzweil 1000 CD in your system's CD drive. The 
auto-install process begins. If it doesn't, choose Run from the 
6



Part 1. Installation
Windows Start menu. Type: your CD drive letter, followed by 
:\setup.exe, then press ENTER to start the setup program. 

4. If Kurzweil 1000 detects an older version of VoiceText voices, it 
asks if you want to automatically uninstall it. Press the Enter 
key for Yes. Press the Escape key for No. Be aware that you 
must first uninstall any older version of VoiceText in order to 
install a new version.

5. Next, Kurzweil 1000 asks you to choose between voiced 
installation or screen reader installation. To use the Kurzweil 
1000 voiced installation, press the ENTER key. To use the 
screen reader installation, press the ESCAPE key. 

Here the installation process diverges. This guide presents the 
Voiced Installation first followed by the Screen Reader Installation. 
If you are planning on using the screen reader, skip over the 
following section. 

Note about .NET install:
Because Kurzweil 1000 requires the .NET Framework, the Kurzweil 
1000 installer checks for it. If it does not exist on your system, the 
installer will install .NET first before installing Kurzweil 1000. The 
.NET install could take about 15 minutes.
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Installing Kurzweil 1000 Version 12
To install Kurzweil 1000 using the voiced installation: 

This procedure assumes that you have completed the Preliminary 
Steps and have pressed ENTER to use the voiced installation. 
Before continuing with the installation, however, note the following 
keyboard keys and their numeric keypad equivalents, which you 
can use throughout the voiced installation process: 

• ENTER key or Accept (top-right key on the keypad) for Yes. 

• ESCAPE key or Cancel (top-left key on the keypad) for No. 

• F1 key or the Help and Status key (bottom-right corner on the 
keypad) for Help; Kurzweil 1000 repeats the prompt. 

• BACKSPACE key or Rewind (left-most key in row 4 on the 
keypad) to go back to the previous prompt.

Continue the voiced installation with the following steps: 

1. A prompt asks if you want to modify the installation options. 
Press ESCAPE to perform a default installation, or ENTER to 
modify the options. The default installation installs Eloquence™ 
U.S. and U.K. voices, ScanSoft recognition engine, FineReader 
recognition engine for English, the dictionary and various other 
options. 

If you chose to customize your installation options, the system 
asks if you want to install the following items. After you hear the 
item's name, press ENTER to install or ESCAPE to not install it. 
Eloquence American English. Eloquence British English. Six 
Eloquence European languages. Finally, you'll be asked about 
bilingual dictionaries, and additional FineReader selections. 

2. Next, the system asks whether or not you want Kurzweil 1000 
to start automatically each time you start your system. Press 
8



Part 1. Installation
ENTER if you do not want Kurzweil 1000 to start automatically. 
Otherwise, press ESCAPE for auto-start. 

3. Press ENTER to confirm your choices and proceed with the 
installation.

4. Sometimes computers need to be shut down and restarted in 
order to complete an installation. If that is necessary, a prompt 
will ask whether you want to Restart your computer now or 
later. (If you choose later, remember that in order to start 
Kurzweil 1000, you should Restart the system first.) If you 
elected not to have Kurzweil 1000 start automatically, you can 
use CONTROL+ALT+K to start Kurzweil 1000. 

5. At this point, you may remove the Kurzweil 1000 CD. 

6. Once Kurzweil 1000 starts up, it reads the license agreement. 
Press ENTER to accept the agreement. 

7. Go to the section entitled, Registering Kurzweil 1000, to register 
the product. 

To install Kurzweil 1000 using the screen reader: 

This procedure assumes that you've completed the Preliminary 
Steps and have pressed ESCAPE to use the screen reader for 
installation. Continue the installation with the following steps: 

1. You will be asked if you want to install certain language 
dictionaries.

2. If you aren't using a hardware speech synthesizer, press 
ENTER to continue. If you are using a hardware speech 
synthesizer, press the UP/ DOWN ARROW key until you hear 
the desired selection, then press ENTER to continue.

3. Next is the request for Customer Information. Here, type your 
user name.
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Installing Kurzweil 1000 Version 12
4. Next, press the TAB key to go to the organization name text 
box. This is an optional entry. If you are using Windows XP, 
there is an additional option: "Install this application for: Anyone 
to use..., or Only Me .... "TAB to go to this option, and select the 
Anyone to use option. Press ENTER: to continue. 

5. Next, specify if you want a Complete or Customized setup. 
Complete is the default option. 

If you want the Complete install: Press ENTER and go to step 8. 

6. If you'd rather customize your install, or want to place Kurzweil 
1000 on a different drive than the default C drive or in a different 
folder: Press TAB to select Customized. 

The Custom Setup dialog opens. The Custom option installs just 
the files you leave selected in this box. The following are 
changes you can make:

To remove the feature files you don't want, use the UP/DOWN 
ARROW keys to go through the list, stop when you hear the 
name of the file you don't want and press the SPACEBAR: key. 
You'll hear, "This feature will not be available" for selections that 
are removed. You cannot remove Main files as they are 
necessary for Kurzweil 1000 to function. 

To change the drive or location in which to place Kurzweil 1000, 
select Main Files, and then press TAB to go to the Change 
command. Press ENTER. In the Change dialog that opens, type 
the name of the desired drive and or location, or press SHIFT 
+TAB to select another location. Press ENTER: to close the 
dialog. 

When you are done customizing the setup, press ENTER to 
continue with the installation. 
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Part 1. Installation
7. Next, the system asks whether or not you want Kurzweil 1000 
to start automatically each time you start your system. Press 
ESCAPE for auto-start. Press ENTER if you do not want 
Kurzweil 1000 to start automatically. 

8. The system may prompt you to Restart the computer. If it 
doesn't, or after you have restarted your computer, you can use 
CONTROL+ALT+K to start Kurzweil 1000. 

9. Once Kurzweil 1000 starts up, it reads the license agreement. 
Press ENTER to accept the agreement. 

10.Go to the section entitled, Registering Kurzweil 1000, to register 
the product. 

If you want to install VoiceText, you can find the instructions after the 
information on Registering Kurzweil 1000. 
Kurzweil 1000 Installation and New Features 11



Installing Kurzweil 1000 Version 12
Registering Kurzweil 1000 
When you first install Kurzweil 1000, it is in Demonstration mode. In 
this mode, all features will be available, but each session is limited 
to two hours. After 30 days, the product expires. To use the full 
product right away, it's important that you register. 

Before you register, here are a few things you must do and know:

1. Consider how you want to register. You can register Online 
through the software if your system has an Internet connection, 
or by telephone. 

2. Also have the serial number ready. We provide this in both print 
and Braille in the following places: on your Certificate of 
Ownership card enclosed with the documentation packaging, 
(this is a square card with the upper-right-corner cut away), on 
the outside of the product box, and on the CD holder. 

If you are upgrading from Version 7, 8, or 9 to Version 10, you 
should use the same serial number with which you registered 
previously, and the system will remember that number for you. 

If you are upgrading from an earlier version than Version 7, you 
will receive a new serial number. 

If you purchased multiple Kurzweil 1000 licenses, the serial 
number for the set is the same. 

During the registration process, you can type or scan the serial 
number from any of the sources mentioned above.

3. Note the Kurzweil 1000 Customer Service contact information. 
In the U.S. and Canada use 1-800-894-5374. For international 
calls use +781-276-0600. Each one of the registration methods 
is straight-forward, but, if after repeated unsuccessful attempts, 
you still need assistance, please call us.
12



Part 1. Installation
Preliminary Registration Steps 

1. In Kurzweil 1000, open the Help menu. You can use ALT+H. 
Then press G to select Register. 

The first of multiple Registration dialogs opens. Some of the 
dialogs you'll use during the registration procedure have the 
Next and Back commands. Press ALT+N or the ENTER key to 
go to the next dialog and ALT+B or ESCAPE to go back to the 
previous one. To get from one item to another, press the TAB 
key. In the first dialog, your cursor is in the Serial Number box. 

2. Type in or scan the serial number. 

If you've registered before, the Serial Number box already 
contains the number. 

Otherwise, to scan the serial number, place the Certificate of 
Ownership card, product box, or CD holder, face down in the 
top-left corner of the scanner. Press the TAB key until you hear 
"Scan." Press ENTER. Kurzweil 1000 scans the serial number 
directly into the Serial Number box in this dialog. 

3. Press TAB then press ENTER to open the next dialog box. 

Kurzweil 1000 asks you to select the registration method you 
want to use. Your cursor is in a list box and the options include: 

Online or Telephone. The Online option is the default.

Use the UP or DOWN ARROW to select the desired option. 

4. Press ENTER to open the next dialog. Skip to the instructions 
for the registration method you selected. 
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Installing Kurzweil 1000 Version 12
Registering Online 
To use this method, your system must have an Internet connection. 
If you have a firewall, it must be configured to accept Internet 
access requests from Kurzweil 1000. Otherwise, you will receive 
messages from the firewall indicating that an unauthorized 
application is attempting to use the Internet. You will need a screen 
reader or an assistant to configure the firewall, or you may call 
Kurzweil 1000 Technical Support. The numbers are: 1-888-995-
9905 or 1-800-894-5374. Please listen for and press the Kurzweil 
1000 Technical Support extension number.

1. After selecting online registration, one of two things can occur:

• If you have an existing serial number, and it is associated with 
only one account, Kurzweil 1000 congratulates you and tells you 
that you have been automatically registered. It then asks if you 
want to update your account information. If you answer Yes, 
Kurzweil 1000 automatically fills in your account information in 
subsequent Registration screens. Make the desired changes 
and press ENTER to complete registration.

• Otherwise, a dialog opens with the cursor in the Account Type 
box. 

2. If a dialog opens, you can select New or Existing in the Account 
Type box.

Select New if you are registering for the first time or with a new 
serial number. Then go to step 3.

Select Existing if you’ve registered before. Go to step 3.

Select Existing - Request Information if you've registered before, 
but have forgotten your password. Press ENTER. 
14



Part 1. Installation
When Kurzweil 1000 finds your information, it sends the details 
to your e-mail account. Check your e-mail for the information, 
then begin the online registration process again. This time, 
select Existing in the Account Type box.

If Kurzweil 1000 is unable to find your information, you may have 
to call Kurzweil Educational Systems Customer Service at 781-
276-0600 or toll-free at 800-894-5374 in the U.S. and Canada. 

3. In the Account name text box, type your account name. Then 
TAB to type your password in the Password box.

If you are creating a new account, pick a unique name that’s 
easy to remember such as your e-mail address. After typing your 
password, TAB to retype it in the Confirm Password box.

Note: It’s a good idea to note this information for future 
reference, as when you upgrade to the next version.

4. Press ENTER to connect to the Kurzweil Educational Systems 
Online Registration page. 

The system verifies that you are online, the server is up, the 
account exists, and that the password is correct. If it finds 
information that is incorrect or incomplete, it prompts you to 
make the necessary changes. 

Your cursor is in the first of a few online registration dialog boxes. 
The system prompts for information that is mandatory. 

5. Provide or change information. Press ENTER to proceed 
through these dialog boxes. 

6. Press ENTER when you are done. 

If registration is successful, Kurzweil 1000 congratulates you. 
The full Kurzweil 1000 product is now activated.
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Installing Kurzweil 1000 Version 12
Registering by Phone 
Two notes regarding phone registration:

• If you are installing and registering Kurzweil 1000 on multiple 
machines, then we recommend using the Systems Code 
Worksheet at the end of the Guide. You can note the systems 
codes, serial numbers and unlock codes, which can greatly 
expedite the registration process. 

• Customer Service representatives are available to take your 
registration between 8:00 a.m. and 4:00 p.m. Eastern Time. The 
Customer Service telephone numbers are: 1-800-894-5374 in 
the U.S. and Canada; +781-276-0600 for international calls. 

The phone registration process follows:

1. Type the unlock code number. 

2. Press ENTER. 

3. If registration is successful, Kurzweil 1000 congratulates you. 
Your Kurzweil 1000 product is now activated.
16



Part 1. Installation
Installing VoiceText and Pronunciation Files

VoiceText Install

The VoiceText CD contains Paul and Kate English-speaking voices. 
It's important to note that you must first install and register Kurzweil 
1000 prior to installing VoiceText. If Kurzweil 1000 detects an earlier 
version of VoiceText on your system, you will receive a message 
asking you if you want Kurzweil 1000 to automatically remove the 
older version. If you answer No, be sure to uninstall it using the 
following procedure:

1. Open the Start menu from the Windows taskbar. 

2. Go to the Programs menu and select the Kurzweil Educational 
submenu. 

3. Choose Uninstall the VoiceText program.

To install VoiceText, simply follow the prompts. The VoiceText CD 
uses a voiced installation.

American Heritage Pronunciation Files Install

Place the product CD containing the American Heritage 
Pronunciation files in the CD drive; go to the "AHD Pronunciation 
Wave Files" folder and click Setup.exe to launch the install.
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Installing Kurzweil 1000 Version 12
Exploring Kurzweil 1000
You may want to explore the following helpful resources:

First, in the Readme.txt file in the root folder of the CD, you'll find 
information on the latest features and changes in Kurzweil 1000.

The second is the \Extras folder, which contains applications that 
some of our customers have found to be useful. 
18



2 Tips for New Users

There are a couple of ways to learn how to use Kurzweil 1000: 

• Go through the New User’s Wizard topics included in the 
product. The Wizard appears upon Kurzweil 1000 startup, 
however, you can also access it by pressing the following key 
combination: ALT+H+W.

• Or you can browse the online Help manual, accessible by 
pressing the following keys: ALT+H+O.

This Tips chapter, however, is designed to give you a jump start.

Keypad or Menu? 
There are two different approaches to using the Kurzweil 1000. If 
you are comfortable with a computer keyboard and already use 
Windows applications, you might want to use the Kurzweil 1000 
menu user interface. 

If you want a simpler introduction to the product, start by learning 
the numeric keypad user interface. There are built-in help systems 
and documentation for both approaches. You may not want to limit 
yourself to one or the other. If you are a Windows user and like 
using the computer keyboard, consider using the keypad interface 
as a way to quickly access frequently used functions.
Kurzweil 1000 Installation and New Features 19



Using the Numeric Keypad
Using the Numeric Keypad
The most important key on the keypad is the Help and Status key in 
the lower-right corner. To find out a key's function, tap the Help and 
Status key then tap a key you want to identify. 

To get a longer, more descriptive explanation of a key's use, tap 
Help and Status, then press and hold down the desired key. 

Some keys have different functions when they're shifted. You can 
get help on a key's shifted function by tapping the Help and Status 
key, then holding down the Shift key and pressing the key for which 
you'd like information. 

Four other frequently used keys are: 

• Start and Stop Scanning. It's the long vertical key above the Help 
and Status key. 

• Start and Stop Reading. It's the long horizontal key in the lower-
left corner of the keypad. This key also acts as a Shift key. 

• Cancel, in the upper-left corner, cancels an action that requires 
confirmation. 

• Accept, in the upper-right corner, completes an action that 
requires confirmation.

At any time, you can get Help from the Online Manual by holding 
down the Shift key (the long horizontal key in the lower left corner 
of the keypad) and pressing the Help and Status key.
20



Part 2. Tips for New Users
Using the Menu System
The following are general notes about using the Menu System:

• Pressing the ALT key on the keyboard gives you access to the 
main menu bar. 

• You can then use the LEFT and RIGHT ARROW keys on the 
keyboard (not the keypad) to move among the main menus. As 
you move to each menu, Kurzweil 1000 speaks the menu name.

• Use the DOWN ARROW key to open a menu and move through 
its items. Kurzweil 1000 speaks a message if an item opens a 
dialog, if it has a submenu, or if there is a shortcut keystroke. Use 
the RIGHT ARROW key to access a submenu. 

• To select a menu item, press the ENTER key on the keyboard. If 
the item has a dialog, that action opens the dialog.

• To get information about a menu item or any part of a dialog, 
press the F1 key. 

• To access the online manual, select Open the Manual from the 
Help menu.

There are also mnemonics, or letter keys that you can press with 
the ALT key, for speedy selection of menu items. For instance, 
pressing the ALT key, then the letter H key for the Help menu, and 
the letter O key for Open the Manual opens the Kurzweil 1000 
online manual. As you become familiar with the Kurzweil 1000 
menus and their items, using mnemonics will become second 
nature.

Consider memorizing shortcut keys for menu items you use 
frequently. Shortcut keys are one to two keys that you press to 
perform an action. For instance, the F5 Function key Starts and 
Stops Reading, the F9 key Starts and Stops Scanning, and the F1 
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Using the Numeric Keypad
key provides help. You can also use standard Windows shortcuts 
such as the Control key plus letter O to open a file.

Another useful Kurzweil 1000 specific shortcut is Shift plus F9 to 
recognize currency. While reading, the following shortcuts can be 
very handy: F12 and F11 increases and decreases reading speed, 
respectively. Control plus D defines a word. Control plus F lets you 
find text and Control plus G takes you to a desired page. 

For a comprehensive list of shortcuts, use the Quick Reference 
from the Help menu by pressing ALT plus H, then Q any time while 
you are using Kurzweil 1000.

Once you have opened the manual, you can, of course, just read it 
using F5. But since it is a lengthy document, you might prefer to use 
an index. Press CONTROL+R to access a list of bookmarks. You 
can move among those bookmarks with the Up and Down Arrow 
kes. Bookmarks have a structure like an outline. The topmost level 
will contain chapter titles. You can burrow deeper into the details of 
a chapter by pressing the Right Arrow, which takes you to 
subchapter titles. When you have found a subject that interests you, 
press Enter, and you will be taken to that section in the manual. 
Finally, CONTROL+F, or Find, allows you to search for a word or 
phrase in the manual, or in the list of bookmarks.
22



Part 2. Tips for New Users
Starting and Shutting Down Kurzweil 1000
There are three additional helpful shortcuts to know. If you do not 
have Kurzweil 1000 starting up automatically when you start up 
your computer, you can start Kurzweil 1000 by pressing 
Control+Alt+K. 

To shut down Kurzweil 1000 using the keypad; press the Cancel 
key twice, followed by the Accept key. To do so with the menu 
system, use the Exit menu item under the File menu, or ALT+F, and 
then X. To power off your computer, which you can do only through 
the keypad, press the Cancel key three times followed by the 
Accept key.

Finding Help and Information
Wherever you are in the product, Kurzweil 1000 provides audio 
feedback through the Verbosity feature and the messaging system. 
However, the following is a short list of the many ways in which you 
can find additional Help and information:

• The F1 key gives you information about the current control.

• The F2 key provides Help for the current dialog box.

• For the Online Help Manual, press ALT+H, then O. In the 
manual, you can use Bookmarks and the Find feature to go to 
and/or search for the information you want. Press CONTROL+R 
to access Bookmarks. You can move among bookmarks with the 
Up and Down Arrow keys. Bookmarks have a structure like an 
outline. The topmost level will contain chapter titles. You can 
burrow deeper into the details of a chapter by pressing the Right 
Arrow, which takes you to subchapter titles. To go to a desired 
subject, press ENTER. You can use CONTROL+F, or Find, to 
search for a word or phrase in the manual, or in the list of 
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Finding Help and Information
bookmarks. Note that on the keypad, pressing the Shift (the long 
horizontal key in the lower left corner of the keypad) and the Help 
and Status keys opens the manual. 

• There's also a Quick Reference, which provides a 
comprehensive list of shortcut keys. Press ALT+H, then Q to 
open the Quick Reference.

• If you want information about the version of Kurzweil 1000 that 
you are using, press ALT+H, then A.

• A good way to find help is through fellow users. You can do this 
by signing up for the Kurzweil 1000 e-mail listserv. Go to the 
following Web page:

http://www.kurzweiledu.com/support_listserv_signup.asp

or send an e-mail to imailsrv@kurzweiledu.com

The body of the message should contain one line. If you are 
sending the message from the e-mail account that you wish 
to use for the list, the message should simply read as follows: 
subscribe K1000.

If you intend to use a different e-mail address for the list, then 
the message should read as follows: subscribe K1000 
followed by the e-mail address.

• You can also search archived questions and answers. Go to: 

http://www.kurzweiledu.com/support_listserv_search.asp
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3 Version 12 New 
Features 

For the most up-to-date feature information, refer to the Readme file 
on the product CD.

The following is a summary of what’s new in Version 12. For 
complete details, go to the online Manual by pressing Alt+H+O. 
Where applicable, Search key words are provided for you to use in 
the online Manual.

• While you may not notice any difference, the internal structure of 
Kurzweil 1000 Version 12 has been overhauled and now uses 
Microsoft .NET Framework. The intent is to make it easier for 
Cambium Learning Technologies to develop features for the 
product going forward.

• Note that Kurzweil 1000 Version 12 now supports 64-bit 
operating systems and Microsoft Windows 7 operating system.

• As always, Kurzweil 1000 has the latest OCR engines, 
FineReader 9.0.1 and ScanSoft 16.2. The new ScanSoft version 
includes recognition languages from the Sami family.

• An especially exciting new feature is the New User Wizard, a set 
of topics that introduces and walks new users through a number 
of Kurzweil 1000 features and preference setups. It appears 
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when you start up Kurzweil 1000, but can be disabled and 
accessed from the Help menu by pressing Alt+H+W. (Search: 
New User Wizard.)

• Currency Recognition has been updated to support new bills. 
Note that Currency Recognition now requires a color scanner. 

• New features and enhancements in reference tools include: 1. 
updates of the American Heritage Dictionary and Roget’s 
Thesaurus. 2. the ability to find up to 114 of your previously 
looked up entries; and last but not least the addition to dictionary 
and thesaurus lookup of human pronunciations and Anagrams. 
When you press the Pronounce button in the lookup dialog 
Kurzweil 1000 uses a human voice to speak the word you are 
looking up. The Anagrams button presents other words that use 
the same letters found in the word you are looking up. To use the 
Pronounce or Anagram features, you must have the American 
Heritage Dictionary Pronunciation WAV Files from the product CD 
installed on your system. (Search: Anagrams button. Pronounce 
button.) 

• Phrase corrections and pronunciations are now supported in 
Version 12. You can apply corrections and change 
pronunciations for more than a single whole word, such as filet 
mignon. (Search: Edit Corrections. Edit Pronunciations.)

• There are two new Reading shortcut key combinations. 
Shift+F11 lowers volume, while Shift+F12 increases volume.

• Several new features are now part of audio file support. First, if 
your system does not have an MP3 Encoder needed to convert 
to audio files, Kurzweil 1000 provides one from the Web during 
the audio file creation process. This requires Internet access. 
Second, you can Save MP3 and WAV files in DAISY 2.02 format 
which retains bookmarks. Third, Bit Rate and Sample Rate have 
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Part 3. New Features
been added to the Create Audio File dialog, enabling you to opt 
for specific settings, rather than using the default rates for Audio 
Quality. Another very exciting feature is Add to Playlist, which 
lets you add the audio file you created to your Windows Media 
Player or iTunes playlist. In addition, you now can have Kurzweil 
1000 report on where you are in an audio file, how many seconds 
have been read and how many seconds remain. (Search: 
Creating and Playing Audio Files.)

• Bookmark Access from the File Open dialog, as suggested to us 
by a user, lets you open a file directly at a selected bookmark. In 
File Open, press the right arrow key for a selected file. If it has 
bookmarks, you can use standard bookmark navigation and 
press enter when you reach the bookmark you want. (Search: 
Opening a File at a Bookmark Location.) 

• Speaking of Bookmarks and files, in Version 12, if you open an 
unencrypted PDF file, Kurzweil 1000 collects the file’s 
bookmarks, allowing you to go to its bookmarked pages. If a 
bookmark description matches text on the page, Kurzweil 1000 
takes you to the first instance of that text. 

• There are several new features and enhancements for working 
with image files. First, you can recognize a subset of or range of 
pages for an image file. When you open an image file, such as 
PDF or TIFF, you can specify All pages or a range of pages. 
Second is the ability to save recognition of a multi-page image or 
PDF file and resume recognition at a later time. (Search: Save 
Recognition.)

• A third image file feature is Image Compression for KES files that 
contain grayscale images. To use this feature, select Threshold 
for the Grayscale Images setting in the Configuration Settings 
dialog. While image compression can greatly reduce the size of 
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your file, it may also have an effect on the display and recognition 
quality. To use the image as is, select Keep As Is, which is the 
default.

• Another image file enhancement is the automatic naming of a 
PDF, TIFF or JPG file. When opening and saving those files, 
Kurzweil 1000, by default, uses the name of the original image 
file.

• Show Image has been revamped and renamed Image Display on 
the Tools menu. There are three options for Image Display: 
Show Image displays the image full screen. Show Both Image 
and Text displays a split screen with the image on one side and 
text in the other. Hide Image shows text only. Page navigation 
works in image views.

• User Devices to Send To is a new feature that enables you to 
send files to devices that emulate a disk drive on a PC. (Search: 
User Devices.) Also for the Send To feature, there’s the addition 
of "Email Client Approach" when sending to an Email Recipient 
is selected. By default, the option is set to MAPI, and is the 
recommended first attempt. If MAPI doesn’t bring up your email 
client, you can now select "Mail To Protocol." Note that the latter 
setting rarely supports email attachments.

• Kurzweil 1000 now supports translations via the Google 
translation engine. In order to use this feature, you must have 
Internet access from your computer. The feature is accessible 
from the Online menu and is available whether or not you have a 
document open. (Search: Getting a Translation.)

• The new Searching Using Regular Expressions feature allows 
you to perform concise searches and global changes in a file by 
using a regular expression, which is a pattern that describes a 
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Part 3. New Features
certain configuration of characters. (Search: Searching Using 
Regular Expressions.)

• On the applications side, there are a couple of new 
developments to report. First, the Calculator application in the 
Standard view now has a History read-only text box that logs 
your calculations as you work. You can clear the stored 
calculations by using the Clear All button. 

• The second feature is a new utility called, KOCRUtil. If you have 
a multi-core processor on your machine, you can use KOCRUtil 
to convert image documents into formats that are not directly 
supported by Kurzweil 1000. The list of formats depends on the 
recognition engine chosen. In addition, you can recognize files 
and files in folders automatically and silently. Before using 
KOCRUtil, however, there are trade-offs to consider. 
Corrections, for example, will not be applied to each page. You 
won't be able to edit or read the document as it is recognized. 
Bookmarks will not be captured for PDF files. And the resulting 
document won't be in KES format (though most of the choices 
will produce output that can be converted to KES by opening 
them within Kurzweil 1000). (Search: KOCRUtil.)
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Additional Changes and Enhancements

• Table Recognition and Table Reading have been clarified. The 
reading setting "Table Identification" has been renamed "Table 
Reading" to better represent the function. A new setting has 
been added to the Recognition Settings dialog, called, "Table 
Recognition" to indicate recognition of tables.

• The menu item named "Rerecognize All Pages under the Scan 
menu has been changed to "Rerecognize Multiple Pages" with a 
change in the mnemonic from A to U. This opens the Range 
dialog in which you can specify pages to rerecognize.

• In Files and Folders, there are a couple of enhancements. The 
File dialog now shows hidden files and folders if this setting is 
enabled in Windows Explorer. When you create a new folder, 
Kurzweil 1000 places it under the current directory rather than 
placing it in the My Documents/Kurzweil Educational System 
directory. 

• In the Print dialog, there is now an option to Fit Image to Paper. 
By default, Kurzweil 1000 fits the original image to the paper size 
you are using to print. The resulting image is usually smaller than 
the original. Disabling this option may result in loss of parts of the 
image, particularly along the bottom and right edges.

• Copy Listview lets you copy any list, including tree view ones, to 
the clipboard.

• In the Audio Spooler dialog, you can now delete the Current Job.

• On the product CD, there is a new Documentation folder 
containing product documentation in multiple file formats, such 
as PDF, BRF and MP3.

Wondering what we might include in the next version? Have an idea 
for a new feature or an enhancement? Use the Kurzweil 1000 
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Part 3. New Features
listserv. To sign up for the Kurzweil 1000 e-mail listserv go to http://
www.kurzweiledu.com/support_listserv_signup.asp or send an e-
mail to imailsrv@kurzweiledu.com. 

The body of the message should contain one line. If you are 
sending the message from the e-mail account that you wish to use 
for the list, the message should simply read as follows: subscribe 
K1000.

If you intend to use a different e-mail address for the list, then the 
message should read as follows: subscribe K1000 followed by the 
e-mail address.
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Systems Code 
Worksheet

If you are installing and registering Kurzweil 1000 from multiple 
machines, and are using the phone registration option, completing 
the worksheet provided on the next page before calling Customer 
Service can help to expedite the process. 

As you go through the installation process note these numbers for 
each machine. They are necessary for obtaining a corresponding 
unlock code, which you will then need to activate each installation 
of the software. 

Space is also provided on the worksheet for the location of each 
machine, and for the corresponding unlock code which the 
Customer Service representative will provide to you. 

For complete details and instructions on product registration, and 
specifically, Registering by Phone, go to Installation and 
Registration at the front of this Guide. 
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Machine Location Serial Number Systems Code Unlock Code



Systems Code Worksheet

Machine Location Serial Number Systems Code Unlock Code
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